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RESUMEN 

 

En el presente trabajo se proponen alternativas de optimización para la red de 

acceso de la compañía Yota de Nicaragua en las inmediaciones del Recinto 

Universitario Simón Bolívar de la UNI (RUSB-UNI). El diagnóstico de la red fue 

realizado mediante drivetest y walktest, identificándose la presencia de múltiples 

servidoras con buena intensidad de señal en el área de interés.  

Posteriormente, se montó la red de Yota, específicamente los 4 sitios que dan 

cobertura al área donde se ubica el RUSB-UNI, haciendo uso de la herramienta RF 

Atoll. 

Como primera propuesta de optimización, se realizó ajustes en el tilt eléctrico de las 

antenas transmisoras para disminuir la presencia de 4 o más servidoras en un 

mismo punto geográfico. No obstante, esta propuesta no fue validada por Yota de 

Nicaragua debido a la utilización de antenas dual-band. Esto también nos limitó a 

proponer alternativa de optimización basada en el azimuth de las antenas 

transmisoras. Finalmente se propone la reubicación de 3 transmisores en un nuevo 

sitio demostrándose mediante simulaciones y predicciones una disminución en el 

número de servidoras con buena intensidad de señal en un punto geográfico dado. 
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OBJETIVOS 

 

OBJETIVO GENERAL 
 

Proponer alternativas de optimización a la red de acceso de Yota-Nicaragua en las 

inmediaciones del RUSB-UNI para mejorar el servicio de datos.  

 

OBJETIVOS ESPECÍFICOS 
 

1. Comprender los principales elementos que componen la tecnología WiMAX 

móvil 802.16e para su descripción. 

 

2. Utilizar herramientas de RF para la elaboración de un diagnóstico de la red de 

acceso de Yota de Nicaragua. 

 

3. Definir los principales parámetros para la optimización de red de acceso en la 

tecnología 802.16e en las inmediaciones del RUSB-UNI. 
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JUSTIFICACIÓN 

 

Actualmente, existen ciertos percances indeterminados de la red de acceso Wimax, 

en el área de cobertura del recinto universitario que no permiten una experiencia 

óptima, en cuanto al desempeño de la misma. 

Como estudiantes de la UNI y usuarios de Yota hemos gozado de la experiencia de 

navegar en nuestros hogares y en el campus, sin embargo, hemos observado y 

corroborado con otros usuarios Yota en los límites del recinto universitario, que el 

desempeño de la red disminuye significativamente con respecto a nuestra 

experiencia en el hogar y esto se mantiene tanto en interiores como exteriores. 

 Por tal motivo nos hemos propuesto realizar un diagnóstico de la red de acceso en 

el área del RUSB-UNI y una vez realizado el diagnóstico proponer alternativas de 

solución.  
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INTRODUCCIÓN 

 

Las nuevas tecnologías de la información y la comunicación (TICS) se han 

convertido en herramientas imprescindibles para el desarrollo de cualquier actividad 

humana en todas las interacciones económicas y sociales, logrando adaptarse a 

una gran diversidad de necesidades de la comunicación cotidiana, razón por la cual 

su demanda aumenta constantemente de manera exponencial. 

En el mercado nicaragüense de las telecomunicaciones operan diversas empresas 

privadas, nacionales y extranjeras de distintos tamaños y capacidad de servicios. 

Entre estas se encuentra Yota, una empresa de origen ruso que fue pionera en 

introducir en Nicaragua la tecnología 4G WIMAX (Worldwide Interoperability for 

Microwave Access) con tarifas accesibles a los niveles de ingreso de los usuarios 

meta. 

 

La UNI -ubicada en un sector céntrico de la ciudad de Managua- representa una 

importante demanda potencial de ancho de banda, determinada por la alta tasa de 

uso del internet como herramienta indispensable que requiere la población 

universitaria para la investigación y las actividades de enseñanza-aprendizaje. 

 

Ante el hecho que la UNI no ofrece opciones de acceso a internet de alta velocidad, 

los estudiantes optan por soluciones portables y económicas; entre las más 

utilizadas esta la provista por Yota, debido a su bajo precio. No obstante, Yota no 

ha logrado la cobertura eficiente en todas las áreas de Managua, entre ellas el área 

de la Recinto Universitario Simón Bolívar (RUSB-UNI). 

 

En el presente estudio se diagnosticó mediante drivetest y walktest el 

comportamiento de la red de acceso y en base a los resultados obtenidos se 

propuso alternativas de optimización de la red haciendo uso de simulaciones y 

predicciones con la herramienta Atoll. 
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CAPÍTULO 1: TECNOLOGÍA WIMAX 

 

Dentro de las denominadas tecnologías que cumplen con el estándar para ser 

llamadas 4 G, tenemos WiMAX. WiMAX (World Wide Interoperability for Microwave 

Access por sus siglas en inglés) se trata del nombre con el que se ha 

comercializado, aunque oficialmente en el ámbito IEEE se denomina WirelessMAN 

o IEEE 802.16.  

 

Considerada en su momento, como una alternativa para la proveer internet en zonas 

rurales, tuvo su penetración e implementación en el mercado mundial entre 2005 y 

2011. Fue ampliamente desplegada en Europa y Asia. En Centroamérica, fue 

implementada en 2009 por la empresa YOTA-Nicaragua de capital ruso. 

 

1.1 Principales Características Técnicas 
 

Entre las principales características técnicas de WiMAX se encuentran [1]:  

 

▪ Cobertura radial de hasta 50 Km.  
▪ Transmisión efectiva de 124 Mbps. Depende del estándar.  
▪ Anchos de canal entre 1,5 y 20MHz  
▪ Utiliza modulación OFDM (Orthogonal Frequency Division), con 2,048 

señales portadoras, que permiten altas velocidades de transferencia.  
▪ Incorpora soporte para la tecnología smart antenna, la cual mejora la 

eficiencia espectral y la cobertura.  
▪ Definida para las frecuencias de hasta 11GHz para conexiones con y sin 

línea de visión, y entre 10GHz y 66GHz para conexiones con línea de visión.  
▪ Incluye mecanismos de modulación adaptativa, mediante los cuales la 

estación base y el equipo de usuario se conectan utilizando la mejor de las 
modulaciones posibles, en función de las características del enlace radio. 

▪ Topología punto-multipunto y de malla.  
▪ Bandas licenciadas y de uso libre. 
▪ Aplicaciones para la transmisión de voz, vídeo y datos. 
▪  Excelente desempeño de transmisión, garantizado vía QoS (quality of 

service) 
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1.2 Evolución del Estándar 802.16 
 

El estándar 802.16 ocupa el espectro de frecuencias ampliamente, usando las 

frecuencias desde los 2 hasta los 11 Ghz para la comunicación de la última milla 

(de la estación base a los usuarios finales) y ocupando frecuencias entre 11 y 60 

Ghz para las comunicaciones con línea vista entre las estaciones bases. En la Tabla 

1, se muestran la evolución de este estándar. 

Tabla 1: Evolución del Estándar IEEE 802.16 (tomado de [2]). 

Estándar Descripción 

802.16-2001 Fixed broadby Wireless Access (10-
66GHz) 

802.16.2-2001 Practica recomendada para 
coexistencia 

802.16c-2002 Perfiles de sistema para 10-66GHz 

802.16a-2003 Capa física y definiciones de MAC 
para la banda de 2-11 GHz 

P802.16b Frecuencias exentas de licencia  

P802.16d Mantenimiento y perfiles de sistema 
para 2-11GHz(proyecto fusionado con 
802.16-2004) 

802.16-2004 Interfaz aérea para conexión a un 
punto de acceso fijo de banda ancha 

 (paquete acumulativo de 802.16-2001, 
802.16a, 802.16c y P802.16d) 

P802.16.2a  Coexistencia con 2-11GHz y 23.5-
43.5GHz(Proyecto fusionado con 
802.16.2-2004) 

802.16.2-2004 Practicas recomendadas para 
coexistencia (mantenimiento y paquete 
acumulativo de 802.16.2.2001 y 
P802.16.2ª)  

802.16f-2005  Base de información para 802.16-2004 

802.16-2004/Cor 1-2005 Correcciones para operaciones fijas 
(co-publicado con 802.16e-2005) 

802.16e-2005 Sistema móvil de acceso inalámbrico 
de banda ancha (Mobile Broadband 
Wireless Access System). 

802.16k-2007 Puenteo en redes 802.16(una 
ampliación de IEEE 802.1D) 

802.16g-2007 Procedimientos plano de gestión y 
servicios 
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P802.16i Gestión de la base de información 
móvil (Project Fusionado en 802.16-
2009) 

802.16-2009 Interfaz aérea para acceso a un punto 
fijo de banda ancha (paquete 
acumulativo de 802.16-2004, 802.16-
2004/Cor 1, 802.16e, 802.16f,802.16g 
y P802.16i) 

802.16j-2009 Retransmisión multisalto 

802.16h-2010 Improved coexistence Mechanisms For 
License-Exempt Operation 

802.16m-2011 Interfaz aérea avanzada con tasa de 
transferencia de 100Mbit/s móvil y 
1Gbit/s sobre punto fijo.  

P802.16n Redes de mayor fiabilidad 

P802.16p Mejoras para soportar aplicaciones con 
conexión Maquina a Maquina (Machine 
to Machine) 

 

1.3 Bandas de Frecuencias 
 

Las redes WIMAX, al contrario que WLAN, deberán por lo general operar en bandas 

de frecuencia de uso licenciado, presentando políticas de QoS (Calidad de Servicio) 

y permitiendo mayor protección y calidad en las comunicaciones. El espectro 

accesible para WIMAX depende del área geográfica en la que se encuentre la red. 

En la Tabla 2, se muestra un resumen de las bandas de frecuencias destinadas a 

WIMAX, así como ancho de bandas, tamaño del FFT entre otros [1]. 
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Tabla 2: Bandas de Frecuencia asignadas para la operación de WIMAX. 
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1.4  Arquitectura de WIMAX 

La arquitectura de WiMAX se desarrolla en una plataforma todo IP. En la Figura 1 

se representa una red WiMAX, que consta de tres partes principales [2]: 

1. MS o SS (Mobile Station o Subscriber Station): Es el equipo terminal del 

usuario que proporciona la conectividad entre el dispositivo final y una 

estación base. 

2. ASN (Access Service Network): La red de servicio de acceso contiene 

todas las estaciones bases (BSs) y las pasarelas ASN (ASN-GWs). El ASN 

es un completo grupo de funciones de red necesarias para proveer acceso 

inalámbrico a todos los usuarios de la red Wimax. 

3. CSN (Connnectivity Service Network): La red de conectividad de servicios 

está compuesta por routers/switches además de un grupo de servidores, 

como el AAA server (Authentication Authorization Accounting), HA server 

(Home Agent), DHCP server, DNS server y PCRF server (Policy and 

Charging Rules Function). 

 

 

Figura 1. Arquitectura de WIMAX (tomado de [2]) 

1.4.1 Puntos de Referencia en WIMAX 

El modelo de referencia de redes WiMAX define varios puntos de referencia entre 

las distintas entidades que componen la arquitectura de esta red. Esos puntos de 
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referencia logran puntos de interoperabilidad entre equipo de diferentes fabricantes. 

Hay seis puntos de referencias obligatorios (del R1 al R6) y dos opcionales (R7 y 

R8) (ver figura 2). 

R1. Definido entre la estación de usuario y la ASN. Incluye protocolos en el plano 

de gestión además de definir el interfaz aire. 

R2. Definido entre la estación de usuario y la CSN. Proporciona autentificación, 

autorización de servicio, configuración IP y gestión de la movilidad. 

R3. Definido entre la ASN y la CSN. Soporta la gestión de la movilidad. 

R4. Definido entre una ASN y otra ASN. Soporta la movilidad entrediferentes ASNs. 

R5. Definido entre una CSN y otra CSN. Soporta el roaming entre diferentes NSPs. 

R6. Definido entre una estación base y una ASN-GW. Gestiona túneles IP para 

eventos de movilidad. 

R7. Interfaz lógica opcional entre la función de decisión y la función de aplicación 

en la ASN-GW. 

R8. Interfaz opcional definida entre una estación base y otra. Facilita la existencia 

de handovers rápidos y sin fallos. 

 

Figura 2: Puntos de Referencia de WIMAX (tomado de [4]) 
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1.4.2 Capa Física de WIMAX 

La capa física (PHY) de WIMAX está basada en multiplexado por división ortogonal 

de frecuencia (OFDM), lo que permite que WIMAX opere en modo NLOS. Tasa de  

transmisión pico de datos  muy alta.  

La tasa pico en la PHY puede ser de hasta 74Mbps cuando se trabaja a un espectro 

de 20MHz. Típicamente, utilizando un espectro de 10MHz usando un esquema TDD 

(Time-Division Duplexing), la tasa pico está cerca de los 25Mbps para tiempo de 

subida y de los 6.7Mbps para tiempo de bajada. Además, WIMAX tiene una 

arquitectura escalable de capa física que permite que la tasa de datos aumente 

fácilmente. Esta escalabilidad  está  apoyada en el modo OFDMA, donde el tamaño 

de la FFT (transformada rápida de Fourier) puede escalarse basado en el canal 

disponible. 

Modulación y Codificación Adaptiva (AMC por sus siglas en ingles) 

WIMAX soporta diferentes esquemas de modulación y esquemas de codificación 

para el control y corrección de errores. En este tipo de redes, el terminal del usuario 

envía información a la estación base servidora sobre la calidad del enlace de radio. 

Basada, en esta medición adaptivamente se selecciona adaptivamente la mejor 

combinación de codificación y Modulación. 

El estándar de WIMAX, define 7 combinaciones de esquema de modulación y 

codificación. La tabla 3, nos muestra estas combinaciones. 

 

Tabla 3: Combinaciones AMC para WIMAX (tomado [5]) 

Modulación Codificación bits/Símbolo 

BPSK 1/2 0.5 

QPSK 1/2 1 

QPSK 3/4 1.5 

16QAM 1/2 2 

16QAM 3/4 3 

64QAM 2/3 4 

64QAM 3/4 4.5 
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CAPÍTULO 2: DIAGNÓSTICO DE LA RED DE ACCESO 

 

En este capítulo se muestran las herramientas y resultados obtenidos para 

diagnosticar el problema en la red de acceso en las inmediaciones del recinto 

universitario Simón Bolívar. 

2.1 WalkTest 
 

Primeramente, se procedió a realizar una solicitud a Yota de Nicaragua para que 

nos apoyaran con un drivetest, debido a que no contamos ni con el software ni con 

el hardware para realizarlo, desafortunadamente, dicha solicitud tiene que pasar por 

un proceso administrativo tequioso lo cual no genera respuestas inmediatas, por tal 

motivo procedimos a idear un walktest con las herramientas que tenemos a 

disposición: 

• Computadora portátil 

• Dongle Yota IGO 

• GPS (Teléfono móvil)  

• Aplicación Runstastic  

 

2.2 Coordinación del Walktest 
 

 

 

Tabla 4: Coordinación de cantidad de horas a utilizar para cada actividad. 

 Actividad Duración 

1 Reunión de coordinación del walktest 1 hora 

2 Walktest 1 hora 

3 Análisis de los resultados 3 horas 

4 Entrega de los resultados 2 días 
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Para la realización del Walktest, coordinamos los siguientes parámetros: 

 

1- Designar la ruta en la que realizaremos el Walktest y definir los puntos de interés 

de medición. 

2- Realizar una descarga continua a lo largo de toda la ruta, desde un servidor FTP 

sin restricciones de ancho de banda, para evaluar el rendimiento real. El tipo de 

archivo era multimedia de video.  

3- Registrar las velocidades según la ubicación geográfica. 

4- Realizar la prueba dos días diferentes. 

5- Analizar los resultados. 

2.3  Ejecución del Walktest 
 

Realizamos tres walktests, el primero fue realizado un día de semana a las 10:00 

AM, posteriormente fue repetido a las 2:00 PM del mismo día, luego se realizó un 

tercer walktest el día sábado donde la afluencia de estudiantes es mínima, 

manteniendo la misma ruta, horario de las 10:00 AM y parámetros del primer 

walktest. Los walktest del día de semana buscaban ver si hay un impacto en la hora 

de realización del mismo En tanto, el walktest del día sábado busca evidenciar el 

impacto del número de usuarios o carga de tráfico. 

Para realizar la recolección de datos, grabamos nuestra ruta con el GPS del teléfono 

móvil y la aplicación “Runstastic”, recopilando así la velocidad alcanzada y la calidad 

de conexión en cada uno de los 18 sitios de interés. 

Los resultados para los 18 puntos de interés y los 3 walktests se muestran en las 

figuras 3, 4 y 5. 
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# Sitio RSSI CINR Velocidad de 
Descarga 

1 Entrada IES -74.39 dBm 10.29 dB 25.6 kB/s 

2 Entrada UNI -70.29 dBm 13.96 dB 3.5 kB/s 

3 Edificio FEC -66.23 dBm 17.83 dB 12.2 kB/s 

4 Estatua Simón Bolívar -56.36 dBm 24.8 2dB 77.8 kB/s 

5 DBE -66.85 dBm 19.18 dB 61.2 kB/s 

6 Costado trasero FEC -59.08 dBm 23.91 dB 39.9 kB/s 

7 Piscina -54.20 dBm 25.08 dB 12.6 kB/s 

8 Química -67.87 dBm 20.59 dB 44.6 kB/s 

9 Posgrado -68.18 dBm 17.46 dB 16.2 kB/s 

10 Interno -68.96 dBm 20.59 dB 12.2 kB/s 

11 Cancha -66.55 dBm 18.83 dB 10.2 kB/s 

12 Costado trasero, edificio 
UNI 

-66.76 dBm 14.63 dB 10.2 kB/s 

13 Área verde detrás de 
edificio 

-79.82 dBm 12.59 dB 10.2 kB/s 

14 Lab. Operaciones 
Unitarias 

-52.80 dBm 16.30 dB 53.9 kB/s 

15 Curva -57.13 dBm 10.66 dB 172 kB/s 

16 Entrada parqueo IES -85.73 dBm 11.41 dB 05.2 kB/s 

17 Entrada principal 
parqueo 

-88.10 dBm 08.32 dB 05.2 kB/s 

18 Entrada IES final -84.64 dBm 12.95 dB 05.2 kB/s 

Figura 3: Walktest 10 AM, día de Semana 
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# Sitio RSSI CINR Velocidad de 
Descarga 

1 Entrada IES -72.39 dBm 09.89 dB 25.6 kB/s 

2 Entrada UNI -68.01 dBm 12.86 dB 4.5   kB/s 

3 Edificio FEC -66.00 dBm 17.83 dB 14.2 kB/s 

4 Estatua Simón Bolívar -57.18 dBm 25.30 dB 75.8 kB/s 

5 DBE -65.20 dBm 20.07 dB 68.2 kB/s 

6 Costado trasero FEC -58.89 dBm 23.33 dB 35.9 kB/s 

7 Piscina -54.20 dBm 24.88 dB 13.6 kB/s 

8 Química -66.85 dBm 20.67 dB 66.6 kB/s 

9 Posgrado -68.15 dBm 17.37 dB 14.2 kB/s 

10 Interno -68.28 dBm 18.55 dB 10.2 kB/s 

11 Cancha -66.25 dBm 18.83 dB 14.8 kB/s 

12 Costado trasero, edificio 
UNI 

-64.80 dBm 14.20 dB 11.2 kB/s 

13 Área verde detrás de 
edificio 

-77.22 dBm 12.23 dB 13.2 kB/s 

14 Lab. Operaciones 
Unitarias 

-54.10 dBm 15.96 dB 55.9 kB/s 

15 Curva -57.13 dBm 11.15 dB 147 kB/s 

16 Entrada parqueo IES -86.37 dBm 11.33 dB 06.2 kB/s 

17 Entrada principal 
parqueo 

-88.98 dBm 08.29 dB 06.2 kB/s 

18 Entrada IES final -83.23 dBm 12.95 dB 06.2 kB/s 

Figura 4: Walktest 2 PM, día de Semana 
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# Sitio RSSI CINR Velocidad de 
Descarga 

1 Entrada IES -74.39 dBm 12.44 dB 23.6 kB/s 

2 Entrada UNI -70.29 dBm 11.96 dB 5.5 kB/s 

3 Edificio FEC -66.23 dBm 16.83 dB 10.2 kB/s 

4 Estatua Simón Bolívar -56.36 dBm 22.86 dB 79.8 kB/s 

5 DBE -66.85 dBm 16.11 dB 63.2 kB/s 

6 Costado trasero FEC -59.08 dBm 23.91 dB 41.9 kB/s 

7 Piscina -54.20 dBm 22.08 dB 12.6 kB/s 

8 Química -67.87 dBm 20.29 dB 39.3 kB/s 

9 Posgrado -68.18 dBm 15.46 dB 19.2 kB/s 

10 Interno -68.96 dBm 20.33 dB 09.2 kB/s 

11 Cancha -66.55 dBm 16.83 dB 10.2 kB/s 

12 Costado trasero, edificio 
UNI 

-66.76 dBm 11.93 dB 10.2 kB/s 

13 Área verde detrás de 
edificio 

-79.82 dBm 10.21 dB 10.2 kB/s 

14 Lab. Operaciones 
Unitarias 

-52.80 dBm 13.05 dB 58.9 kB/s 

15 Curva -57.13 dBm 12.36 dB 139 kB/s 

16 Entrada parqueo IES -85.73 dBm 11.41 dB 06.2 kB/s 

17 Entrada principal 
parqueo 

-88.10 dBm 08.32 dB 05.2 kB/s 

18 Entrada IES final -84.64 dBm 14.95 dB 06.2 kB/s 

Figura 5: Walktest 10 AM, día sábado
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2.4 Análisis de resultados: 
 

Como logramos apreciar, la red presenta bajo rendimiento en las inmediaciones del 

recinto universitario, ya que los valores promedio de descarga del operador Yota en 

otras áreas de Managua promedian los 512 kB/s (4Mbps) en velocidad de descarga, 

en tanto, en la UNI los valores oscilan entre 5.2 y 172.5 kB/s, siendo el valor 

promedio de velocidad experimentado en este recorrido de 30 kB/s,manteniéndose 

tanto en día de semana como en fin de semana, donde la carga de tráfico es 

exponencialmente menor, no habiendo diferencia significativa con respecto al 

aumento de velocidad para el enlace de bajada entre los dos días, nosotros 

esperábamos que debido a una menor presencia de usuarios en el recinto 

universitario, pudiésemos experimentar mayores velocidades, sin embargo, al 

observar que las velocidades promedio para cada uno de los tres días son de 30.43 

kB/s, 31.18 kB/s y 30.38 kB/s respectivamente, no se identificó un cambio 

significativo, además de estar muy lejos de las velocidades promedio que se 

experimentan en otras áreas de Managua, evidenciando de esta manera que se 

presentan problemas en la entrega del servicio en las inmediaciones del recinto 

universitario. 

De igual manera, evidenciamos que los niveles de señal de CINR no son óptimos 

para establecer un enlace adecuado, por tanto, buscara una servidora con mejores 

niveles de RSSI, resultando este fenómeno, debido a la alta presencia de muchos 

sectores con niveles óptimos de potencia (RSSI) en el área del RUSB-UNI.  

 

2.5 DriveTest  
 

Una vez realizado el walktest, nos acercamos a Yota de Nicaragua con nuestros 

resultados, para solicitar su apoyo con la facilitación de un drivetest con equipos 

certificados, y de esta manera ser capaces de medir el desempeño de la red de 

manera precisa en parámetros de RSSI y CINR, a lo que respondieron anuentes a 

colaborar siempre y cuando le facilitáramos los resultados de nuestro trabajo, a 

continuación, presentaremos los resultados: 
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2.6 DriveTest RSSI 

 

Figura 6: Drivetest basado en RSSI en recinto universitario. 

 

El indicador de intensidad de señal recibida o RSSI por sus siglas en inglés, es la 

intensidad de señal medida en dBm que logra recibir un dispositivo final, en la 

tecnología Wimax se consideran valores aceptables entre -80 a -50 dBm para lograr 

entregar el servicio [6]. 

Como podemos observar en la figura 6, los niveles de RSSI en más de un 90% de 

las muestras, se encuentran con niveles inferiores a 80 dBm, lo cual indica que la 

intensidad de la señal es adecuada para establecer un enlace estable en esta 

tecnología, por lo tanto, no podemos evidenciar ningún problema como resultado de 

esta variable medida en el drivetest. Cabe señalar, que aun utilizando equipos no 

certificados para walktest, los resultados son muy similares a los de este drivetest 

para el RSSI. 
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2.7 Drivetest CINR 

 

Figura 7: Drivetest basado en CINR en recinto universitario. 

 

CINR (Carrier to interference + Noise ratio) es una razón que relaciona la potencia 

de la portadora transmitida, en proporción con los niveles de ruido e interferencia 

que corrompen a la misma, esta prueba de campo mostrará los niveles de ruido e 

interferencia que presenta nuestra área de cobertura en relación a nuestra portadora 

[6]. 

Como podemos ver en la figura 7, tenemos un 66.19% de las muestras recopiladas 

en nuestra zona de interés con los niveles de CINR menores o iguales a 15 dB, 

podemos observar que la mayor concentración de estos niveles se encuentra dentro 

del recorrido realizado en el recinto universitario Simón Bolívar. Una vez más, este 

resultado se corresponde con lo encontrado para la CINR en los walktest.  

En [7], se encontró que se considera como un buen rango para la CINR 20 dB o 

mayor. Por el contrario, si la CINR tuviera un valor inferior a este, causaría en el 

modem realizar un intento de cambio de estación base [6-7]. Este fenómeno fue 

evidenciado durante los walktest realizados en el recinto, y denominado en este 

documento como “ping-poneo”. 
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CAPÍTULO 3: DISEÑO DE UNA RED WIMAX 

Una vez que diagnosticamos el problema vía walktest y drivetest, procedimos a 

montar los 4 sitios de la red de Yota que cubren nuestra zona de interés en la 

herramienta Atoll. 

Atoll propone algoritmos para realizar el diseño de redes inalámbricas, a manera de 

ejemplificación usaremos el algoritmo perteneciente al estándar WIMAX, dicho 

algoritmo fue usado para realizar el estudio y algunas simulaciones del presente 

trabajo [8]. 

Toda propuesta de optimización no se realiza directamente a la red física, sino, que 

se debe de simular en una herramienta RF, para poder evaluar el comportamiento 

de desempeño de dichas optimizaciones antes de ser llevadas a la práctica. Para 

simular esta red hacemos uso de la herramienta Atoll de Forsk.[8] 

A continuación, se muestra el procedimiento de configuración típico para una red de 

tecnología Wimax en el software Atoll, así como algunas funcionalidades que nos 

permite esta herramienta: 

3.1 Elección de plantilla de tecnología 
 

El primer paso para crear una red usando el software Atoll, es seleccionar qué tipo 

de tecnología se simulará, para ello el software presenta plantillas para diversas 

tecnologías soportadas. Esto se realiza en la pestaña File >New>From a 

Document Template.  

Para nuestro estudio seleccionaremos la tecnología Wimax 802.16e, por ser la 

tecnología utilizada por Yota de Nicaragua. 

 

 

 

 

 

 

 

 

 

 Figura 8: Plantilla de tecnologías en Atoll 
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3.2 Configuración de coordenadas 
El software Atoll puede realizar simulaciones en cualquier parte del mundo; por tal 

motivo permite configuración de coordenadas de geo-referencia en cualquier parte 

del globo terráqueo. Para nuestra región se usó la zona WGS 84/ UTM Zone 16N, 

correspondiente a la zona geográfica de Nicaragua, esto se configura desde la 

pestaña Tools> Options. 

Figura 9: Configuración de coordenadas. 

 

 

3.3 Importación de mapas Digitales 
La herramienta de simulación Atoll, hace uso de mapas digitales de elevación 

(Digital Elevation Models - DEM), los cuales son una representación visual y 

matemática de valores de elevación sobre el nivel del mar, que permite caracterizar 

el relieve y los accidentes geográficos de la zona. 

Dichos mapas son desarrollados por software especializados para esta tarea y 

representados por archivos digitales. Tales mapas son de vital importancia ya que 

aportan información necesaria para hacer los cálculos de la difracción en los 

modelos de propagación. 
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Para nuestro proyecto en particular los mapas digitales de Nicaragua fueron 

facilitados por nuestra universidad, para el desarrollo de este proyecto investigativo. 

Dicha información fue importada al software usando varios archivos, que entre ellos 

incluían información sobre los cuerpos de agua, calles principales, entre otros. 

Dentro del software para invocar estos archivos se busca la pestaña File > Import 

para encontrar la ubicación de tales archivos dentro del directorio en la computadora  

Figura 10: importación de Mapas. 

Figura 11: Mapa Importado.  
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Posteriormente seleccionamos la configuración de código de colores que mostrará 

el relieve de nuestro mapa en Ventana de terreno> Click derecho > Propiedades 

>Clutter hights: 

 

Figura 12: Código de colores. 

 

Figura 13: Mapa Importado y con código de colores. 
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3.4  Configuración de sitios 
La interfaz del software Atoll posee la ventana llamada “Explorer”, donde se pueden 

verificar y configurar todas las opciones de la red, desde su modelo de propagación, 

mapas digitales y demás parámetros técnicos a considerar en el diseño, por medio 

de un directorio raíz desplegable, igualmente haciendo uso del “click derecho” para 

mostrar parámetros adicionales referentes a la opción seleccionada. 

El primer paso es obtener los campos requeridos para crear un sitio en el software. 

La información corresponde a la tabla “Sites” que se puede encontrar desde la 

ventana Explorer>Data>Sites>Click Derecho>Open Table. 

 

 

Figura 14: Ventana de sitios. 

Luego recomendamos hacer uso del mapeo de los campos y copiar para luego 

pegar en una hoja de cálculo de Microsoft Excel (archivo .csv), para posteriormente 

importarlos a Atoll, o bien, ingresarlos manualmente desde Atoll.  

En nuestro ejemplo hemos usado los sitios: “Ericsson”, “Enatrel”, “Plaza el Sol” y 

“UNAN” donde definimos el nombre que se le otorga al sitio y la geo-referencia 

según el formato de coordenadas y comentarios adicionales. 

 

 

Figura 15: Campos de sitios. 
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3.5  Ubicación de Sitios 
La ubicación de sitios representa el uso de geo-referencia para poder ser mostrado 

en el software. El tipo de coordenadas compatibles con Atoll ya se modificó en el 

apartado de configuración de opciones de coordenadas. El único proceso para su 

importación es respetar dicho formato de geo-referencia y suministrar el archivo con 

toda la información de los sitios necesarios. A través de Data>Sites>Open 

Table>Click Derecho>Import>Seleccionar Archivo .csv>Import. 

 

 

Figura 16: Ubicación de sitios. 
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3.6  Zona de cómputo 
La zona de computo, es una funcionalidad de Atoll que permite limitar la zona en la 

cual realizara sus cálculos pixel a pixel en las predicciones, a un área geográfica 

especifica de interés, y de esta manera realizar cálculos solamente en las zonas 

deseadas. Se puede lograr desde Click Derecho>Zones>Computation 

Zone>Dibujar computation zone. 

  

 

 

Figura 17: Zona de cómputo definida. 

 

3.7 Importación de Antenas 
 

La herramienta de planeación Atoll, en su ventana “explorer” posee un directorio 

llamado “antennas”, dicho elemento almacena las características de los 

transmisores que estarán disponible para el proyecto a desarrollar. Por defecto, este 

contiene un número de transmisores disponibles de diversas características. Sin 

embargo, este número de transmisores no se ajusta a cada diseño de red. Por este 

motivo Atoll, permite importar otros transmisores, en función de sus características 

como: ganancia, patrón de radiación vertical, patrón de radiación horizontal, 

frecuencia mínima de operación, frecuencia máxima de operación entre otros.   

Esta información de los transmisores normalmente es suministrada por los 

fabricantes. En nuestro trabajo hicimos uso del sitio web www.commscope.com, 

donde se puede encontrar un catálogo de transmisores disponibles y permite 

descargar la información de ellos, para ser alojados en Atoll. Dicho website permite 

file:///C:/Users/JorgeAlejandro/Downloads/jh/Capitulo%20II/www.commscope.com
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obtener un archivo en formato .csv con toda la información de un modelo de antena 

seleccionado. 

Luego de descargar el archivo de la antena se recomienda realizar un proceso de 

filtrado, debido que los modelos de transmisores traen consigo mucha información 

adicional, en función de todas las bandas de frecuencias, tilts eléctricos, ganancias 

soportadas por la antena. Además, Atoll no permite más de veinte tipos de antenas 

en una única importación. Por esta razón recomendamos, filtrar solo las antenas 

que se usarán en su diseño.  

Luego de filtrar el archivo .csv se procede a importarlo. Atoll a través del manual 

recomienda ciertos métodos; nosotros recomendamos usar 

Data>Antennas>ClickDerecho>OpenTable. Posteriormente desde la tabla de 

referencia de antenas hacer ClickDerecho>Import>Seleccionar 

Archivo.csv>Import. Es de vital importancia siempre configurar el campo Field 

Separator y verificar que las entradas Source y Destination sean las mismas. Para 

una correcta importación de antenas la ventana tendría que lucir como la figura 6. 

 

 

Figura 18: Ventanas de importación de antena 
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3.8 Configuración de celdas 
 

Para que el software pueda crear las primeras simulaciones es necesario configurar 

las celdas, que es donde se definen parámetros como la frecuencia de operación, 

potencia de transmisión, entre otros. Para tener acceso a esta configuración 

accedemos en: Data>Transmitters>ClickDerecho>Cells>OpenTable. La figura 

19 muestra los valores utilizados en nuestras simulaciones. 

 

Figura 19: Configuración de celdas. 
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Para configuración de esta simulación utilizamos los parámetros técnicos 

proporcionados por Yota de Nicaragua: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.9 Predicciones 
 

El software Atoll permite hacer dos tipos de predicción de cobertura, unas que 

permiten analizar los niveles de señal y otras que permiten analizar la calidad de la 

señal. El primer tipo solo se basan en predicciones de señal, mientras que el 

segundo tipo dependen de las condiciones de carga de la red y de las interferencias. 

En la tabla 5 se muestra un resumen de las predicciones disponibles en Atoll. 

Tabla 5: Parámetros técnicos de Yota de Nicaragua. 

Nº           Parámetro                           Valor                             

1 Frecuencia                            2.5 – 2.7 GHz              

2 Tipo de Antena              Andrew 2.3 – 2.7 GHz       

3 Estaciones Base                     Sitios Yota 

4 Azimuth                            XXXX- Confidencialidad Yota 

5 Altura Móvil (mts)                        1.5 

6 Altura BS (mts)                              30 

7 Tilt                                    XXXX- Confidencialidad Yota 

8 Vecinos                                   Automático 

9 Preamble Index                XXXX- Confidencialidad Yota 

10 Canalización                            5 canales                 

11 Preamble Power                        36 dBm 

12 WiMAX Equipment                 Default (DL) 
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Tabla 6: Predicciones disponibles en Atoll. 

Nombre  Dependencia del 
tráfico 

Descripción 

Coverage by Transmitter No Permite predecir el área de 
cobertura de un transmisor 
analizando el mejor transmisor 
en cada pixel del mapa. 

Coverage by Signal Level  No Permite predecir las zonas de 
cobertura por la intensidad de la 
señal del transmisor en cada 
pixel del mapa. 

Effective Signal Analysis(DL) 
Effective Signal Analysis(UL) 

No Permite analizar el nivel de 
distintos tipos de señales  LTE 
tanto en el downlink como 
uplink. 

Overlapping Zone No Permite calcular las zonas donde 
existe cobertura de dos o más 
transmisores.  

Coverage by Best Bearer(DL) 
Coverage by Best Bearer(UL) 

Si Permite calcular y mostrar los 
mejores servicios portadores de 
radio bearers disponibles 
basándose en C/(I+N) en cada 
pixel. 

Coverage by Throughput(DL) 
Coverage by Throughput(UL) 

Si Permite calcular y mostrar 
niveles de troughtput en cada 
pixel del mapa, tanto en 
downlink como uplink. 

Coverage by C/(I+N) Level(DL) 
Coverage by C/(I+N) Level(UL) 

Si Permite analizar los niveles de 
interferencia y de portadora a 
interferencia y ruido. 

Coverage by Quality Indicator(DL) 
Coverage by Quality Indicator(UL) 

Si Permite calcular y mostrar la 
probabilidad de error de 
bloques (BLER) en cada pixel del 
mapa. 

 

 

Después de diseñar nuestra red en Atoll con los parámetros brindados por la 

compañía Yota, procedemos a realizar la predicción por overlapping zone para 

poder visualizar aquellos puntos en el mapa con la presencia de 4 o más portadoras, 

es deseable que en cada punto del mapa no se encuentren más de 3 portadoras. 
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3.10 Predicción de Overlapping Zone 
 

Al realizar una predicción por Overlapping Zone (Zona de superposición), nos 

permite evaluar cuántos transmisores convergen en la misma zona geográfica 

transmitiendo en la misma gama de frecuencias, derivándose en problemas de 

interferencia.   

La figura 20 muestra el resultado de la predicción de Overlapping Zone, 

mostrándonos la presencia por cada pixel en el mapa de cuantas servidoras se 

encuentran presentes convergiendo en un mismo punto. Cada color mostrado en la 

figura representa un numero de servidoras distinto, siendo el color rojo (4 o más 

servidoras), la condición no deseable para cualquier red. 

 

 

 

 

 Figura 20: Predicción por Overlapping zone de 1, 2, 3 y 4 transmisores. 
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A continuación, en la figura 21 mostramos las zonas donde convergen 4 o más 

servidoras. El área dentro del círculo azul es donde está ubicado el RUSB-UNI: 

 

Figura 21: Predicción por Overlapping zone de 4 o más transmisores. 

 

 

Figura 22: Histograma basado en Overlapping zone de 4 o más transmisores. 
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La figura 22 muestra el histograma de la predicción por overlapping zone. Esta nos 

muestra que el 16.236% de nuestra zona de cálculo presentan 4 o más servidoras, 

y una buena parte de este porcentaje afecta el área donde está ubicado el RUSB-

UNI (Ver círculo azul en la figura 21). 

Gracias a este diagnóstico, podemos intuir que el principal causante de los 

percances que muestra nuestras malas experiencias como usuarios finales de la 

red Wimax, es debido a la alta presencia de transmisores con niveles óptimos de 

potencia en la zona del recinto universitario. 
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CAPÍTULO 4: PROPUESTAS DE OPTIMIZACIÓN 
 

Luego de haber diagnosticado mediante walktest, drivetest, y predicciones con el 

software Atoll, en este capítulo se muestran las propuestas de optimización para 

corregir el problema de interferencia por múltiples servidoras. 

Para corregir este problema, podemos llegar a realizar dos tipos de optimizaciones, 

una que nos permita variar el azimuth y otra que nos permita variar el tilt eléctrico, 

sin embargo, modificar el azimuth es muy poco deseado por los operadores, debido 

a que esto implica contratar personal especializado para realizar ajustes físicos a la 

antena. No obstante, dado que estas antenas cuentan con tilt eléctrico, el cual es 

una optimización que se puede ejecutar vía software, procedimos a proponer esta 

optimización: 

 

4.1 Optimización por medio de cambio de tilt eléctrico 
 

En optimización de redes inalámbricas, el tilt eléctrico representa la inclinación (en 

dirección vertical) del haz de propagación radioeléctrica, gracias a este parámetro 

podemos direccionar de manera precisa nuestro transmisor para cubrir nuestra área 

de interés. 

En cada emplazamiento existen 6 transmisores, de esos transmisores, por pareja 

comparten el mismo azimuth y tilt eléctrico, la empresa decidió arreglarlo de esta 

manera debido a que el ancho del haz de las antenas utilizadas es de 65º, debido a 

que contamos con este tipo de antena, decidimos realizar una propuesta de 

optimización por tilt eléctrico tomando en cuenta  que mantendremos los azimuths 

pero modificaremos los tilts eléctricos, de tal manera que una antena cubre el área 

cercana al emplazamiento y la otra la elevamos para que cubra el área lejana en la 

misma dirección, a continuación en la tabla 5 se muestra la optimización. 

Cómo podemos ver, los emplazamientos de “Plaza el sol 3” y “Plaza el sol 6” tenían 

el mismo tilt eléctrico. Luego de la optimización, “Plaza el sol 3” quedo con un tilt 

eléctrico bajo, de tal manera que cubra el área cercana a la radio base y “Plaza el 

sol 6” lo hemos dejado con tilt eléctrico alto para que cubra el área lejana de la radio 

base a este método le llamamos “near field/far field”. Este mismo proceso se aplicó 

con los demás sectores de interés. 
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Tabla 7: Modificaciones de tilt eléctrico. 

 

 

 

Luego de haber modificado nuestros valores de tilt eléctrico en nuestra simulación 

de red Wimax, a continuación, mostramos predicciones de overlapping zone para 

evaluar el resultado de la optimización. En la figura 23 y 24 se muestran los 

resultados de la predicción por overlapping zone y su respectivo histograma. Se 

puede observar, que se logró reducir las zonas de overlapping zone en un 71.9% 

con respecto al overlapping zone de la red actual. 

Estación Tilt Eléctrico Original Tilt Eléctrico Simulación 

Plaza el sol 3 2 2 

Plaza el sol 6 2 7 

Ericcson 1 5 2 

Ericcson 4 5 7 

Enatrel office 1 4 2 

Enatrel office 4 4 7 

Plaza el sol 1 4 2 

Plaza el sol 4 2 7 

Plaza el sol 2  5 2 

Plaza el sol 5 5 7 

Ericcson 3 2 2 

Ericcson 6 2 7 

Unan 1 5 2 

Unan 4 2 7 
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Figura 23: Evaluación de propuesta de optimización (tilt eléctrico modificado). 

 

Figura 24: Histograma de presencia de transmisores (tilt eléctrico modificado). 
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Dicha propuesta es óptima, ya que las modificaciones de tilt eléctrico pueden 

ejecutarse vía software, siendo esta una opción tanto efectiva como de bajo costo. 

Sin embargo, al presentar esta propuesta de optimización al personal de contacto 

del operador Yota de Nicaragua, nos comentaron que ellos utilizan antenas dual-

band en su infraestructura de red, estas son antenas que operan en dos bandas de 

frecuencia utilizando la misma antena. Por tanto, en lugar de que cada sitio tenga 6 

antenas independientes, realmente son 3 antenas, por lo que la modificación de tilt 

eléctrico de manera independiente, no es posible. Debido a esto, una propuesta 

optimización por azimuth o tilt mecánico tampoco es viable. 

 

4.2  Optimización por instalación de nuevo sitio. 
 

Debido a que nuestra propuesta de optimización anterior fue descartada debido a 

la falta de viabilidad por tipo de antena, propondremos la siguiente solución: 

Desmontar 3 de los sectores que actualmente cubren el recinto universitario, 

específicamente los transmisores “Ericcson 4”, “Enatrel office 4” y “Plaza el Sol 4”, 

para luego ubicarlos en las inmediaciones de “Radio Ya” aprovechando su 

infraestructura de torre ya existente para desplegar equipos de telecomunicaciones. 

Una vez creado el nuevo sitio podemos definir el azimuth y los tilt eléctricos de cada 

transmisor, cabe señalar que las modificaciones a estos parámetros fueron 

seleccionadas de tal manera que se pudiera reducir la mayor cantidad de 

overlapping zone, luego de realizar pruebas exhaustivas, quedamos con estas 

configuraciones que mostramos en la siguiente tabla. 

Tabla 8: Modificaciones de tilt eléctrico y azimuth, nuevo sitio. 

 

Las figuras 25 y 26 muestran los resultados de predicción de overlapping zone y su 

respectivo histograma. Como podemos ver tenemos una reducción de overlapping 

zone de 4 o más servidoras de equivalente a un 73.5 % de reducción. Esto muestra 

que la instalación de una nueva estación sería una solución apropiada para 

optimizar la red de Yota actual en el campus RUSB – UNI, no obstante, sería una 

opción muy costosa de implementar para el operador. 

Sitio anterior Sitio Nuevo Tilt eléctrico Azimuth 

Ericcson 4 Radio ya 1 2 290 

Enatrel office 4 Radio ya 3 7 28 

Plaza el sol 4 Radio ya 5 3 155 
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Figura 25: Evaluación de propuesta de optimización (Nuevo sitio). 

       

 

Figura 26: Histograma de presencia de transmisores (Nuevo sitio). 
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. 

CAPITULO 5: CONCLUSIONES Y RECOMENDACIONES 
 

5.1 Conclusiones 
 

En la presente monografía se presentan propuestas de optimización para la red de 

acceso de Yota de Nicaragua en las inmediaciones del Recinto Universitario Simón 

Bolívar. 

Primeramente, se ejecutó un walktest, evidenciando problemas de conectividad en 

las inmediaciones del recinto universitario, lo que repercute en los valores promedio 

de velocidad de descarga obtenidos en los walktest. Sin embargo, este resultado no 

fue concluyente, por tal motivo se realizó un drivetest de RSSI y CINR con equipos 

de la empresa Yota de Nicaragua, encontrando que los valores de RSSI están en 

los niveles deseados. No obstante, se obtuvo que un 66.16% de las muestras 

obtenidas en el recorrido muestran valores por debajo de 15 dB para el CINR, 

siendo esta la causa de los problemas de conectividad experimentados durante los 

walktest. 

Una vez diagnosticado el problema, procedimos a diseñar una red con las 

configuraciones proporcionadas por Yota para esta red en la herramienta Atoll, una 

vez montada la red con esta configuración, evidenciamos por medio de predicción 

por overlapping zone, que le problema es ocasionado por la presencia de 4 o más 

servidoras en un 16.236% de nuestra área de interés definida en el software. 

Una vez visto esto, propusimos una primera optimización basada en tilt eléctrico, 

utilizando una metodología la cual definimos como “cercano/lejano” reduciendo la 

convergencia de 4 o más servidoras en un 71.9%. Sin embargo, al presentar nuestra 

propuesta a la empresa Yota de Nicaragua,                                                                                                                                                                                                                                                                                  

nos informaron que son antenas dual-band, las cuales no permite cambios de tilt 

eléctrico independientes a cada uno de los transmisores. Esto también ocasiona, 

que una posible propuesta de optimización de tilt mecánico o azimuth, aunque sean 

válidas, no sean viables en este caso.  

Finalmente, se propone la reubicación de 3 transmisores de los diferentes sitios que 

cubren nuestra zona de interés y emplazándolos en las inmediaciones de la Radio 

Ya debido a que presta la infraestructura de torre para desplegar equipos de 

telecomunicaciones. Con esta alternativa se logró una reducción de un 73.5% de la 

presencia de 4 o más servidoras en el área de interés definida en Atoll. 
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5.2 Recomendaciones 
 

1- Ya que el walktest fue realizado de manera empírica, creemos que sería 

recomendable que la Universidad Nacional de Ingeniería contara con 

equipos de walktest certificados, de tal manera que los estudiantes puedan 

incorporar este elemento a sus prácticas dentro de su formación académica. 

 

2- Recomendamos basados en nuestra experiencia, el trabajar de cerca con el 

operador de la empresa de telecomunicaciones que experimenta el 

problema, ya que facilita en gran medida el trabajo. Sin embargo, hay que 

armarse de abundante paciencia, debido a que los tiempos de respuesta no 

están en pos del desarrollo de las monografías, si no, a sus propios procesos 

internos. 
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